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Technical Support

If you have difficulties using Web Dictate please read the applicable topic before requesting 
support. If your problem is not covered in this user guide please view the up-to-date Web 
Dictate Online Technical Support at www.nch.com.au/webdictate/support.html . 
If that does not solve your problem, you can contact us using the technical support contacts 
listed on that page.

Software Suggestions

If you have any suggestions for improvements to Web Dictate, or suggestions for other related 
software that you might need, please post it on our Suggestions page at 
www.nch.com.au/suggestions/index.html

. 
Many of our software projects have been undertaken after suggestions from users like you. 
You get a free upgrade if we follow your suggestion.

www.nch.com.au/webdictate/support.html
www.nch.com.au/suggestions/index.html
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NCH Software Suite

This is a useful way to browse all the software available from NCH Software

You can see a set of products by type like Audio, Video and so on and view the product. From 
there you can try out the product and it will download and install it for you to trial. If you already 
have the product installed then you can click "Run It Now" and the program will be launched for 
you.

There is also a list of features for products in the category, in case you just wish to know how 
to say "Edit a Video File", and here it will offer you a product with that ability.

Search  

Search our website for products matching any keywords you type. 

See more of our software 

Browse our website for more software. 

Subscribe to our newsletter  

You can subscribe to our newsletter for announcements of new releases and discounts. You 
can unsubscribe at any time. 

See the latest discounts for purchase 

See the latest discounts we are offering for purchasing our products. 
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Overview: What Web Dictate Does

Web Dictate is web-based dictation software that lets you create, edit and manage recordings 
from a convenient browser-based interface.

The advantage of Web Dictate is that you can install it on just one computer and let anyone 
access it from any Windows, Mac OS or Linux PC as long as it has Java installed and has a 
web browser supporting Java applets. 

Using Web Dictate, you are no longer stuck having to install software on your machine in order 
to create your dictations.

You can travel to conferences overseas, make dictations on any computer, and then send 
them to your secretary for transcription. 

This software is designed to be very easy and intuitive to use. 

Within minutes you will be able to set up the software and start recording dictations. 

Features 

l  Install on one computer and record dictations from any computer in the world using a 
web browser. 

l  Send dictations via email, FTP, LAN, or via Express Delegate. 
l  Allow an unlimited number of users to use the software (licenses must be purchased for 

every user). 

System Requirements 
Server Machine 

l  Windows XP / 2003 / Vista / 2008 / 7. 
l  LAN or broadband internet connection. 

Client Machines 

l  Windows, Mac OS X, or Linux. 
l  Java version 6.0 or later. 
l  Web Browser supporting Java applets (e.g. Mozilla Firefox, Microsoft Internet Explorer, 

Apple Safari). 
l  LAN or internet connection. 
l  Sound card, microphone (for recording), speakers (for play-back). 
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Installation and Setup

The Administrator can set up Web Control Panel access and User licenses so regular users 
can access the software and record dictations.

After Web Dictate is installed, go to Options -> "Administration" tab. Set the Administrator User 
Name, Email Address and Password as appropriate.

Next, click on the Web Access tab of the Options dialog. 

l Next, specify a port on which you want to run the Web Control Panel.
l Please ensure you do not choose port 80 to avoid conflicts with other programs, as well 

as to avoid security problems.

Now click on the "Web" button in the main window. 

l  When your browser opens, try to log in using your Administrator login details. 
l  After successful login, the Main Menu page of the Web Dictate Control Panel will be 

displayed Web Control Panel . 

The final task to complete initial setup is to add users. 

l Click on the "Users" link in the Web Control Panel main menu.
l  Add each user for whom User licenses have been purchased: (

click here to purchase licenses
).  Select Add User and enter the user details exactly as they appear on the 

registration. 

New users can also be added from the application's main window, under File -> 
"Register New User...". In this case, the default password for that user will be blank. 

Note that only the Web Dictate Administrator will have the access to Add New User 
feature. For more information, please refer to Web Control Panel . 

That's all the setup required - your users will now be able to have access to Web Dictate. 
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Purchasing and Registering

Web Dictate is free for evaluation use only.

There are 2 alternative licensing options for Web Dictate. 

l  Purchase Individual User Licenses  You may purchase a Web Dictate user license for 
each individual software user.

l  The Web Dictate User license includes free use of the related software Express 
Dictate. You can download Express Dictate from 
http://www.nch.com.au/express/index.html

. 
l The same registration code can be used to register Express Dictate.
l Note that with this option, if you want to change email address, you will need to 

purchase another registration.

This option is suitable for smaller transcription services with less than 20 users.

To view pricing or purchase a user license online, please click here. 

l  Purchase a Web Dictate Site Installation License 
A site license licenses a single installation of Web Dictate for unlimited use. As many 
users as required may be added per site without any further charge. 

This option is suitable to larger transcription services with more than 10 users (or 
anticipated users).

To view pricing or purchase a Web Dictate site license online, please click here. 

WARNING: Please be honest. It is both fraud and breach of copyright (piracy) to use another 
person's user license. Piracy will be reported to the police and unprofessional conduct will be 
reported to any appropriate medical or legal professional ethical organization. 
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General Usage

At the heart of Web Dictate is its web-based interface where user access is set up and where 
all your users will create and manage their dictations. 

The only difference in the Web Control Panel for the Administrator and for the User is that 
users do not have privileges to manage user licenses. Administrators are free to log in and go 
about testing the software prior to allowing user access. 

NOTE: It is an expectation that the Administrator account is not to be abused. It is ONLY 
meant for setting up Web Dictate, managing User licenses and for generally testing the 
software. It is not intended to be used in an everyday situation for recording and managing 
dictations. For that you must purchase User licenses, here. 

Web Dictate's feature base is at once very simple and yet powerful. You can: 

l  Record dictations 
l  Edit dictations 
l  Delete dictations 
l  Send dictations via email, FTP, LAN, or Express Delegate. See Express Delegate 

details here 
l  Manage User Licenses (Administrator Only) 
l  Non-administrative users do not have access to other users' recordings. 
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Shortcut Key Reference

l  Ctrl+W Open Web Control Panel 
l  Ctrl+O Open Options dialog 
l  F1 Open Help documentation 
l  Alt+F4 Exit Web Dictate 

The following shortcut keys apply to the web interface whenever the recording window is 
displayed. 

l  F9 Play 
l  R Record 
l  Esc  Stop 
l  Home Jump to start 
l  F7 Rewind 
l  F8 Fast Forward 
l  End Jump to end 
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Options

Open the Options dialog by clicking on "Options" in the Web Dictate main window, or going to 
File -> Options.

Options -> General 

l  Run Web Dictate automatically on system startup - choose the desired startup option 
for Web Dictate. 

l  Service Settings - for details, please refer to this page Service Settings 
l  Email Settings  This dialog specifies how dictations should be sent via email. Note that 

the sending of email happens on the Web Dictate server computer, not on the client's 
computer.

For more information, please refer to this page Sending Emails using SMTP 

Options -> Administration  
Administrator Access 

Here you can set the administrator's user name, email address, and password.

Note that you can only have one administrator account, and that the user ID for the 
administrator is 0. 

Options -> Web Access  
Web Access Server 

Here you can specify the port on which the Web Dictate server runs, start or stop the 
server, and run a routing test. See Routing Options Page for more details. 
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Problems With Login?

If you are an Administrator, your user name and password can be set using the Options button 
on the toolbar of the program itself.

By default, the user name for the Administrator is Admin and password is blank. 

If you are a normal user, you need to ask your Administrator to set up the Web Dictate account 
for you.

Once you are added to the Web Dictate users list, you will receive an email with your login 
details. 
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Software License Terms

1.  The copyrights in this software and any visual or audio work distributed with the software 
belong to NCH Software and others listed in the about box. All rights are reserved. 
Installation of this software and any software bundled with or installed-on-demand from this 
software is licensed only in accordance with these terms.

2.  By installing, using or distributing this software you, on your own behalf and on behalf of 
your employer or principal, agree to be bound by these terms. If you do not agree to any of 
these terms, you may not use, copy, transmit, distribute, nor install this software - return it 
to the place of purchase within 14 days to receive a full refund.

3.  This software, and all accompanying files, data and materials, are distributed "as is" and 
with no warranties of any kind, whether express or implied except as required by law. If you 
intend to rely on this software for critical purposes you must test it fully prior to using it, 
install redundant systems and assume any risk.

4.  We will not be liable for any loss arising out of the use of this software including, but not 
limited to, any special, incidental or consequential loss. Your entire remedy against us for 
all claims is limited to receiving a full refund for the amount you paid for the software.

5.  You may not use this software in any circumstances where there is any risk that failure of 
this software might result in a physical injury or loss of life. You agree to indemnify us from 
any claims relating to such unauthorized use.

6.  You may copy or distribute the installation file of this software in its complete unaltered 
form but you may not, under any circumstances, distribute any software registration code 
for any of our programs without written permission. In the event that you do distribute a 
software registration code, you will be liable to pay the full purchase price for each location 
where the unauthorized use occurs.

7.  Use of statistics collected by the software is subject to the NCH Software Privacy 
Statement which allows automatic anonymized collection of usage statistics in limited 
circumstances.

8.  The contract arising out of this agreement is governed by the laws and courts of the 
Australian Capital Territory.
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Web Control Panel - Web Interface

Web Interface 
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Web Control Panel - New Dictation

Click the New Dictation link in the control panel to record a new dictation. You will first receive 
a prompt requesting a name for the file you are about to record (a generic file name is given by 
default). You will then be taken to the Recording page where you can commence recording. 
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Web Control Panel - Existing Dictations

Click the Existing Dictations link in the control panel to view all your previously recorded 
dictations. All recorded dictations are listed here, even those that you have sent via email. 

In the Existing Dictations list, the status of each dictation is displayed. If you have not recorded 
audio for a particular dictation, you will see "No content recorded" in its status column. The 
duration of recorded dictations is also displayed. 

For any individual file in the list, you can perform the following actions by clicking the 
associated icon to the right of the dictation listing: 

l  Edit the dictation - Clicking the edit icon will open the dictation in the recording page, 
where you can add to the dictation, or record over parts of the dictation. See the 
Recording Page

 topic for more information about making and editing recordings. 
l  Send the dictation - Clicking the send icon will prompt you to select the recipient of the 

dictation. You can send to the default recipient, or select another recipient from the list. See 
the Recipients topic in this manual for more information about setting up recipients in Web 
Dictate. 

l  Delete the dictation - Click the delete icon to delete the dictation from the list. You will be 
asked to confirm the deletion before the action is carried out. 

Create New Dictation

To create a new dictation from the Existing Dictations list, click the Create New Dictation link 
found near the top of the tab. You will be prompted to enter a file name for the recording you 
are about to make, then will be directed to the recording page. See the Recording Page topic 
in this manual for more information about recording.

Load Existing Dictation

To add dictation files from your computer to the Web Dictate web interface, click the Load 
Existing Dictation link found near the top of the Existing Dictation tab. Browse to the dictation 
file and click Load Now to upload the dictation and add it to the list.
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Web Control Panel - Sent Dictations

Click the Sent Dictations link in the control panel to view dictations you have sent from Web 
Dictate. For any individual file in the list, you can perform the following actions by clicking the 
associated icon to the right of the dictation listing: 

l  Edit the dictation - Clicking the edit icon will open the dictation in the recording page, 
where you can add to the dictation, or record over parts of the dictation. See the 
Recording Page

 topic for more information about making and editing recordings. 
l  Resend the dictation - Clicking the send icon will prompt you to select the recipient of the 

dictation. You can send to the default recipient, or select another recipient from the list. See 
the Recipients topic in this manual for more information about setting up recipients in Web 
Dictate. 

l  Delete the dictation - Click the delete icon to delete the dictation from the list. You will be 
asked to confirm the deletion before the action is carried out. 

Sending Dictations

Dictations can be sent either from the Existing Dictations section by clicking the email icon to 
the right of any dictation listing, or directly from the recording page by clicking the Send button. 
Before dictations can be sent successfully, at least one recipient must be set up. See the 
recipient

 topic in this manual for more information about setting up recipients and the sending 
methods available with Web Dictate. 
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Web Control Panel - Recipients

Click the Recipients link in the control panel to add recipients you send dictations to from Web 
Dictate. Dictations can be sent via Express Delegate dictation workflow management software, 
email, a local area network (LAN), or an FTP server.

To add a new recipient: 

l Click the link Add New Recipient link, found near the top of the tab
l In the page that appears, enter the recipient's name and select the send method, the file 

format, and an encryption key if required.

Select and configure a send method: 

l  Express Delegate: Dictation Workflow Management Software 

Learn more about this program at www.nch.com.au/delegate/

Express Delegate manages dictation files and tasks by assigning transcription tasks to 
typists based on manager-created rules and tracking the status of all tasks.

Many of the features of Express Delegate are available remotely, via your web browser. 

To use this method to upload dictations, you must have an account on an Express 
Delegate server. If you are unsure of the Express Delegate server address, server port 
number, login email address, or login password, please contact your Express Delegate 
server administrator. 

l  Email  

If you select this option, the recipient will recieve the dictation as a file attached to an email. 
Enter the email address of the typist in the Email Address field. 

l  Local Area Network (LAN) 

The fastest way to send typing to the typists is over your local computer network. To do 
this, your typist must have a shared folder on the network. If necessary, ask your systems 
administrator to create a suitable folder. 

Enter the full path of the shared folder in the "Folder or Drive" field. Please note that your 
typist's software (e.g., Express Scribe) must also be set up accordingly to recieve dictations 
using this method. 

l   File Transfer Protocol (FTP) Server 

Web Dictate can upload dictations directly to an FTP server. This is faster than the email 
option, but requires that your typist have access to an FTP server to store the files. 

Enter the Server, Username, Password and Directory as set up for your typist's FTP server.
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Send File Format 

After selecting the send method, select which file format you want to send the files in. The DCT 
format allows for extra sender information to be embedded into the file, the WAV format does 
not. 

Security 

Finally, determine whether or not you need to send the recordings with encryption. For 
dictations containing sensitive or privileged information, this option should be enabled. Note 
that the encryption feature is only available to licensed users. 
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Web Control Panel - Users

Click the Users link in the control panel to add users who can create and send dictations from 
Web Dictate. Note that only a Web Dictate Administrator can add users. Administrators can 
add licensed Users to grant access to your Web Dictate installation. Click here to purchase 
licenses. 

To add a new user license: 

l Click the Register New User link, located near the top left of the tab.
l  In the page that appears, type in your registration details exactly as provided to you. 

Additionally, you need to create an access password for the user's Web Dictate account. 

The user will need the User Name and Web Dictate Access Password  in order to log into the 
account. 

To add a new site license:  

l Click the Register Site License link, located near the top left of the tab.
l  In the page that appears, type in your registration details exactly as provided to you. 

The user will need the User Name and Web Dictate Access Password  in order to log into the 
account. 
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Web Control Panel - Recording Page

The recording page is where you create your Web Dictate recordings or edit existing 
recordings. A screenshot of the recording window is shown below. 

The different parts of the recording window are as follows: 
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1. File menu - access all the main options such as Play, Record, Stop, Rewind and Fast 
Forward.

2. Save - saves the current dictation and puts it in the "Existing Dictations" folder.
3.  Send - sends the current dictation to the specified recipient in the "Recipients" section. If 

the send was successful, the file will be put in the "Sent Dictations" list, otherwise it will go 
in the "Existing Dictations" folder. 

4. Cancel - cancel out of the recording page and discard the current dictation.
5. The filename of the current dictation.
6. The current position in the dictation.
7. Total duration of the current dictation.
8.   Recording Method - when you click the pull-down menu to the right of this label, you can 

select where the audio will be inserted when you click Record. 

l  Append - the new recording is added to the end of the dictation. 
l  Overwrite - the new recording commences from the very start of the dictation. 
l  Insert - the new recording starts at the current position in the dictation. 

9. This is the seeker/slider bar. It lets you navigate through to any point in your recording.
10.  The volume display lets you see the changing volume levels of your voice as you are 

making the recording. If this display is not moving, it means that nothing is being recorded. 
11. Play - play your current dictation.
12. Record - start recording to the dictation file.
13. Stop - stop recording.
14. Go to Start - jumps back to the beginning of the dictation.
15. Rewind - rewinds the dictation three seconds for every click of the button.
16. Fast Forward - fast forwards the dictation three seconds for every click of the button.
17. Go to End - jumps to the end of the dictation.
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Screen References - Options ~ Web Access

Browser Access

For more information on setting up Browser Access, see this Knowledge Base article: 
www.nch.com.au/kb/10233.html

. 
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